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Welcome to XOHM i

Welcome to XOHM

XOHM is a wireless Internet service that lets you get online at broadband speed. The 
XOHM WiMAX network connects you to the people you need, the entertainment you 
love and the information you can’t live without. You’ll connect to the Internet using your 
choice of computer without long-term contracts or complications.

Getting started with XOHM is simple: just connect your XOHM Modem MAX-206M2 by 
ZyXEL (XOHM Modem) to your computer and set up your XOHM account, and you’ve 
got broadband.

This guide covers all the information required to set up, install, and configure your 
XOHM Modem.

� Get Started

� Your XOHM Modem Settings

� Troubleshooting

� User Information and Warranty

For more information about XOHM WiMAX, visit www.xohm.com.
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Section 1

Get Started
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2 Your XOHM Modem

Section 1A

Your XOHM Modem

This section outlines the basic layout of your modem and connections.

What’s in the Box
� XOHM Modem MAX-206M2 by ZyXEL 

� Power adapter

� Ethernet cable 

� XOHM Modem Setup Assistant CD

� Get Started Guide 

� User Guide 

Before setting up your XOHM Modem, make sure you have all the items listed  
above. If any items are missing, contact your XOHM retailer or call XOHM Care at  
877-333-XOHM (877-333-9646).

Modem Requirements
� CD-ROM drive (for XOHM Modem Setup Assistant only)

� 32MB RAM minimum (64MB recommended)

� 20MB available hard disk space

� One available 10/100Mbps Ethernet port

� Web browser (XOHM Modem is compatible with Internet Explorer 6 and higher, 
Firefox 1.5 and higher, and Safari 2.0. It may also function with other browsers.)

� Credit card for activation

Download from Www.Somanuals.com. All Manuals Search And Download.
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Get to Know Your Device
Your XOHM Modem lets you connect to the XOHM WiMAX network to provide fast 
and easy wireless connectivity to the Internet in your home or office.

WiMAX Overview

Computer or

Home Network

Telephones

[future service]

WiMAX

Tower

XOHM Modem

MAX-206M2 by ZyXEL

Internet
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4 Your XOHM Modem

Device Connectors (back of device)

1. Power jack (black): Connects the power adapter to power the modem.

2. Reset button (red): Resets the unit back to factory defaults (use ONLY as a last 
resort).

3. Antenna connectors (gold): Connect a remote antenna (available separately) to extend 
a signal from a strong area (such as near a window) to a weaker area where it may 
be more convenient to place the modem. [Coming soon.]

4. Phone ports 1 / 2 (gray): Connect telephones to the modem. [Future service.]

5. Ethernet ports 1/2 (yellow): Connects the modem to computers and/or a Wi-Fi router.

Power
Adapter

Reset
Button

Remote 
Antenna

[coming soon]

Telephones
[future service]

Computer/
Wi-Fi Router
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Modem LED Display (front panel)

1. WiMAX LEDs: The leftmost LED indicates WiMAX connectivity. A blinking LED 
indicates that the unit is ranging, while a solid LED indicates that a connection has 
been established and that the modem is ready to transmit and receive. The three 
LEDs to the right indicate the signal strength of the reception (1-3). These LEDs 
will be green when illuminated. 

2. Phone 1 / Phone 2 LEDs: Illuminates when the VoIP phone “line” is in use. If no voice 
accounts are configured, the LED will be off. If a voice account is configured and 
registered, the LED will be green. When the connected phone is off-hook, the LED 
will blink. When there is new voicemail on the account, the LED will be amber 
(optional). [Future service.]

3. LAN 1 / LAN 2 LEDs: Illuminates when the modem is connected to the computers or 
other networking devices. This LED will be green, and will flash as data is sent 
through the connection.

Note Signal Strength LEDs: The number of signal strength LEDs illuminated reflects the strength 
of the WiMAX signal being received by the XOHM Modem; however, the strength of signal 
does not affect the speed of your connection. As long as there is sufficient signal strength to 
make a connection, you may achieve maximum connection speed. (For more information 
about signal strength, see “XOHM WiMAX Signal Strength” on page 20.)

Signal Strength
Indicator

WiMAX
Signal

Phone 1 & 2
[future service]

LAN 1 & 2 Power
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6 Your XOHM Modem

4. Power LED: Indicates if the unit has power and is operating correctly. A blinking LED 
indicates the unit is loading the firmware and configuration, while a solid LED 
indicates the unit is ready for operation. This LED will be green.

Positioning Your Modem
Your XOHM Modem has a convenient, contemporary design that allows for simple 
setup. When setting up your modem:

� Only use your XOHM Modem indoors. Avoid moisture or extreme temperatures.

� For improved reception, place the modem near a closed window.

� Position the modem within easy access of a reliable power supply.

� Make sure the modem is near enough to your 
computer to easily connect the modem to the 
computer using the supplied Ethernet cable. 

� The unit’s omnidirectional antennas are built 
into the sides (“handles”) of the modem case. 
Make sure to provide ample space around the 
device to ensure maximum WiMAX signals.

� The antennas must be installed to provide a 
separation distance of at least 20cm from all persons 
to satisfy Federal Communications Commission radio 
frequency exposure compliance.   

� Where possible, keep your modem at least 
one foot away from other electronic devices, 
such as Wi-Fi routers and cordless phones,  
to avoid potential signal interference.

5dBi Omnidirectional Antennas
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Note Accessories: Various accessories for your device, such as remote antennas and battery 
packs, will be available from XOHM in the future. Please visit www.xohm.com for details and 
updates.
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8 Install Your XOHM Modem Using the XOHM Modem Setup Assistant

Section 1B

Install Your XOHM Modem Using the  
XOHM Modem Setup Assistant

This section outlines the basic steps to install your modem using the XOHM Modem 
Setup Assistant included on the XOHM Modem Setup Assistant CD that came with  
your modem.
 

Install the XOHM Modem Setup Assistant 

1. Insert the XOHM Modem Setup Assistant CD into your computer’s 
CD drive.

� The installation should begin automatically. If your computer 
does not launch the installation program, click Start >  
My Computer and double-click on the CD Drive. From the  
CD drive file list, click XOHM Modem Setup Assistant.exe to  
begin the installation.

Note You can set up your modem without running the XOHM Modem Setup Assistant, but we 
recommend that you use the setup assistant for the sake of simplicity and to facilitate 
future updates and diagnostics.

Note Depending on your system settings, you may be required to log in as an administrator to 
install software on your computer.

The screen images in this user guide are illustrative and may not reflect the final software.
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3. Follow the onscreen instructions to complete the installation wizard.

� Accept the terms of the XOHM License Agreement.

● If you do not agree with the terms, click Cancel. Your installation will be 
cancelled and the program will exit.

� Select a destination folder for the program. (Default is C:\Program Files\XOHM\ 
Modem Setup Assistant.)

� Click Install at the “Ready to Install the Program” prompt.

� When the Completed screen appears, select Launch XOHM Modem Setup Assistant 
and click Finish to complete the installation and launch the setup program.

Note If your computer has a current Internet connection, the program will automatically check 
for a software update. If the New Software Found screen is displayed, click Next and follow 
the onscreen instructions to update the XOHM Modem Setup Assistant software. 
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10 Install Your XOHM Modem Using the XOHM Modem Setup Assistant

Install Your XOHM Modem
1. If it did not launch automatically, launch the XOHM Modem Setup Assistant by 

clicking Start > (All) Programs > XOHM > XOHM Modem Setup Assistant. The Welcome 
screen appears. 

2. Follow the onscreen instructions to install your modem.

� Insert the round end of the power adapter into the modem’s power port and plug 
the other end into a power source. (The Power LED should illuminate.)

� Insert one end of the supplied Ethernet cable to your computer and the other 
end into the yellow LAN 1 port. (The LAN 1 LED should illuminate.)
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a few moments for the signal to find your modem.

� If the setup assistant displays any green circles ( , , or ), you’re in fine 
shape. Click Next and proceed to step 7.

� If you do not have any green circles showing ( ), or if you would like to look for a 
stronger signal, try moving the modem to a different location (nearer a window, 
on a higher floor, or away from other electronic devices; for tips on locating your 
modem, follow the onscreen instructions or see “Positioning Your Modem” on 
page 6). Wait several seconds at each location and click Test to see if you’re 
getting a signal.

� If you cannot acquire a WiMAX signal, call XOHM Care at 877-333-XOHM (9646). 
 

Signal 

Strength
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12 Install Your XOHM Modem Using the XOHM Modem Setup Assistant

4. Click Activate My Modem to connect to the XOHM activation site.  

Your Web browser will launch and you will see an Activation in Progress screen. When 
the XOHM site opens, follow the instructions to explore the XOHM service options, 
choose the option that’s right for you, and activate XOHM. When complete, submit 
your order.

5. Wait for activation and provisioning to complete. (Activation by XOHM is typically 
fast but may take several minutes.)

� During activation and provisioning, make sure that you do not disconnect your 
modem. Disconnecting will interrupt the process.

� When activation and provisioning have been completed, the Activation Complete 
screen appears. The modem will disconnect and reconnect automatically and the 
modem indicator lights (LEDs) will turn off and on in sequence (Power, LAN, and 
Signal Strength).
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Yes, Help Me Set Up My Router. (Go to “Set Up a Router (optional)” on page 14.)

– or –

If you are not setting up a wireless network, click No, I Will Not Use a Wireless Router. 
You will proceed to the Setup Complete screen, where you can:

● Click Visit XOHM to go to the XOHM website to explore additional XOHM 
features and personalize your XOHM WiMAX service.

– or –

● Click Finish to complete activation.

If activation is unsuccessful or if the operation times out, click Retry to retry.  
If activation is still unsuccessful, refer to the Troubleshooting information on 
page 40 for possible solutions. If none of those addresses the problem, call  
XOHM Care at 1-877-333-XOHM (9646) for assistance.

Once the Setup Complete screen has been displayed, your modem setup is complete. 
Click Finish and then launch your browser to surf the Web, check your email, and more, 
all with the speed and reliability of the XOHM WiMAX network. 
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14 Install Your XOHM Modem Using the XOHM Modem Setup Assistant

Set Up a Router (optional)
If you want to set up a wireless router, the XOHM Modem Setup Assistant will take you 
through a basic router setup and connection test. For advanced router configuration, 
consult your router’s documentation.

1. From the Activation Complete screen (see step 6 above), click Yes, Help Me  
Set Up My Wireless Router.

2. Follow the instructions to connect your router to the modem and test your 
connection.

3. When you have successfully set up your router, Setup Complete is displayed.

● Click Visit XOHM to go to the XOHM website to explore additional XOHM 
features and personalize your XOHM WiMAX service.

– or –

Click Finish to complete activation.

Download from Www.Somanuals.com. All Manuals Search And Download.



Install Your XOHM Modem Using the XOHM Modem Setup Assistant 15
In

st
al

la
ti

on
: M

od
em

 S
et

up
 A

ss
is

ta
ntUsing the XOHM Modem Setup Assistant After 

Installation
Once your modem is activated, you can use the XOHM Modem Setup Assistant program 
to access information about and links to online support and settings for your XOHM 
Modem.

� Click Start > (All) Programs > XOHM > Modem Setup Assistant or double-click on the 
XOHM Modem Setup Assistant icon ( )on your computer’s desktop to launch 
XOHM Modem Setup Assistant. The XOHM Modem Setup Assistant Current Status 
screen appears (see below). 

The XOHM Modem Setup Assistant Current Status Screen 

This screen provides the following information and tools:

A Connection Status and Network Information.

A
B

C
D

E

F
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16 Install Your XOHM Modem Using the XOHM Modem Setup Assistant

B Signal Strength (see “XOHM WiMAX Signal Strength” on page 20).

C Quick Links: 

● My Account takes you to your online XOHM account page. 

● XOHM Support launches the XOHM Support website.

● Settings launches your online modem settings tool, the Modem Configuration 
Interface. See “Modem Configuration Interface Overview” on page 28 for 
more information.

D General Information (WiMAX IP Address and Modem IP Address.

E Link to the Connection Details screen of the XOHM Modem Setup Assistant.

F Menu Bar: 

● File > Exit exits the XOHM Modem Setup Assistant.

● Tools provides links to the XOHM coverage map and the XOHM speed test 
site. Selecting Tools > Options displays a window that lets you select software 
update options.

● Help lets you link to an online help file with a Modem Setup Assistant user 
guide (Modem Setup Assistant Help) and display the XOHM Modem Setup 
Assistant version information (About XOHM Modem Setup Assistant).
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� Click Connection Details from the Current Status screen to display the XOHM 
Modem Setup Assistant Connection Details screen. 

Connection Details – XOHM WiMAX Status

� Click XOHM WiMAX Status (see above) to display your current XOHM status, 
including network name, signal strength, Ethernet 1 and 2 connections, and 
phone line information (future use).
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18 Install Your XOHM Modem Using the XOHM Modem Setup Assistant

� Click Network Information (see below) to display network and connection details 
including modem and WiMAX IP addresses, LAN IP subnet, packet error rate, 
base station ID, frequency, data transmission and reception estimates, transmit 
power, and connection duration. 

Connection Details – Network Information
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nt� Click About My Modem (see below) to display information about your XOHM 

Modem, including model number, software and hardware versions, memory 
usage, MAC Address, and the modem uptime. 

Connection Details – About My Modem

� Click Current Status from any of the Connection Details pages to return to the 
Current Status screen.
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20 Install Your XOHM Modem Using the XOHM Modem Setup Assistant

XOHM WiMAX Signal Strength

Signal 
Strength

Modem Signal 
Strength 
Indicator LEDs

Modem Setup 
Assistant Signal 
Strength Icons

Description of the 
Signal Strength Level

Inactive

> -90dBm

No lights Your connection to the 
XOHM network is 
currently weak. This can 
probably be solved by 
placing your modem in a 
better location. Once 
moved, please test your 
signal again.

Adequate 
> -80dBm to  
> -90dBm

1 light   

You have an adequate 
WiMAX signal, but it 
could probably be 
improved. Try placing your 
modem closer to a closed 
window and test your 
signal again.

Good 
> -70dBm to

> -80 dBm

2 lights   

You have a strong 
connection to the XOHM 
network. You can 
experiment with modem 
placement if desired.

Best 
> -70dBm 3 lights   

You have the best 
possible WiMAX 
connection.
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Section 1C

Alternate Method: Install Without the  
Modem Setup Assistant

If you do not wish to use the XOHM Modem Setup Assistant to set up your XOHM 
Modem, you may set it up using the configuration interface. 

Set Up the Modem
1. Find a place for your XOHM Modem. See “Positioning Your Modem” on page 6 for 

details and suggestions. 

2. Disconnect any existing LAN (Ethernet) connections or routers from the computer 
you are going to be using for your XOHM Modem. (Router setup will come later.)

Note Although you may set up your modem without using the XOHM Modem Setup Assistant, 
we recommend that you use the setup assistant for the sake of simplicity and to facilitate 
future updates and diagnostics through the XOHM Modem Setup Assistant. 
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3. Plug in the modem and connect it to your computer.

� Insert the round end of the power adapter into the modem’s power port and plug 
the other end into a power source. (The Power LED should illuminate.)

� Insert one end of the supplied Ethernet cable to your computer and the other 
end into the yellow LAN 1 port. (The LAN 1 LED should illuminate.)

4. Check the modem’s indicator lights to confirm your WiMAX signal. It may take a 
few moments for the signal to find your modem.

� If the WiMAX Signal indicator is solid green, the modem is receiving a WiMAX 
signal. Proceed to step 5.

� If the WiMAX Signal indicator is blinking, try moving the modem to a different 
location (nearer a window or away from other electronics). Wait several seconds at 
each location to see if you’re getting a signal.

� If you cannot acquire a WiMAX signal, call XOHM Care at 877-333-XOHM (9646).

Tip For more information about signal strength, see “XOHM WiMAX Signal Strength” on 
page 20.

WiMAX
Signal

LAN 1 Power
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5. Launch your Web browser.

� The XOHM website will be displayed.

� Follow the onscreen instructions to choose your XOHM service option and 
activate XOHM. When complete, submit your order.

6. Wait for activation and provisioning to complete. (Activation by XOHM is typically 
fast but may take several minutes.)

� During activation and provisioning, make sure that you do not disconnect your 
modem. Disconnecting will interrupt the process.

� Your XOHM Modem will automatically power cycle (turn off and back on) during 
provisioning. When the WiMAX Signal indicator returns to solid green, your modem 
is active and ready to use.

7. To confirm your modem’s status, navigate to your favorite website. If you are able 
to access the XOHM site but no other website, provisioning may not be complete. 
Wait a few minutes and try again. 
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Connect a Router (optional)
Once you have set up your XOHM Modem and confirmed your Web connection, you 
can set up your router as needed.

1. Consult your router’s documentation for setup details.

2. Disconnect the Ethernet cable from your computer and connect it to the router’s 
Internet port. (It will go directly from the XOHM Modem’s LAN 1 port to the router.)

3. Connect an Ethernet cable from the router to your computer.

4. Make sure the modem’s LAN 1 indicator is illuminated and test connectivity by 
launching the Web browser. If you are having difficulties, double-check your 
router’s settings.

Note Maintain a minimum distance of 1 foot between the XOHM Modem and your Wi-Fi router 
to avoid signal interference.

Tip For added security, change your modem password after setting up your router.  
See “Access the Modem Configuration Interface” on page 28 for more information.
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Section 1D

Telephone (VoIP) Settings

Your XOHM Modem is able to support VoIP (Voice over Internet Protocol) telephony, 
meaning you will be able to use your XOHM WiMAX connection to provide both voice 
and Internet services.

Coming soon: Telephone and voice (VoIP) service from XOHM will be available in the future.  
Visit www.xohm.com frequently for details and announcements.
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Section 2

Your XOHM Modem Settings
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Section 2A

Modem Configuration Interface Overview

This section reviews all the basic settings options available through the XOHM  
configuration interface.

Access the Modem Configuration Interface
1. Open the computer’s Web browser, type http://192.168.100.1 in the address bar, and 

press Enter. The Configuration Interface login screen will be displayed.

Note The settings available through the Configuration Interface may also be accessed online 
through the Settings link in the XOHM Modem Setup Assistant.

The screen images in this user guide are illustrative and may not reflect the final software.
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e2. Enter the User Name, enter 1234 in the Password field, and then click Login. 

� The default User Name is user. The default password is 1234.

3. You may be prompted to enter a new password.

� To keep using the default password, click Ignore or Clear and continue to the  
next steps.

� To change the password, enter and retype a new password and click Apply to 
change the password. You will need to complete step 2 again to log in with your 
new password before continuing.
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4. The configuration interface Home screen appears.  

5. From the Home screen, access your settings options either through the Home 
area icons in the middle of the window or through the menu bar options on the left 
side of the window. 

While it’s a good idea to familiarize yourself with these menus and options, rest 
assured that you may never need to use any of them. Your XOHM Modem’s initial 
setup, detailed in section 1, is designed to automatically detect and assign the correct 
settings for the majority of installations.

Home Area IconsMenu Bar
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The menu bar and the Home area icons offer the same options. The only difference is 
that the menu bar includes an option to return to the Home screen.

The options available include:

� Advanced – includes tabs for Port Forwarding and Trigger Port.

� Tools – includes tabs for Password Setup, Remote Access, and Software Update.

Using the Menus
The settings menus use just a few simple tools to help you make changes.

� Most of the menus allow you to enter or change values directly. If you’re satisfied 
with the changes, click Apply at the bottom of the screen to save your settings. To 
cancel your changes, click Cancel. 
 

� Many settings options allow you to choose from drop-down lists. Click on the arrow 
and select an option. 

� Certain menus contain lists that allow you to edit, delete, or export settings. In  
these cases you will highlight a line and click on the action you want to take:  
Edit ( ), Delete ( ), or Export ( ).
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Section 2B

Advanced Menu

This section reviews all the settings options available through the menu bar’s Advanced 
menu.

Display the Advanced Menu
1. From the Home screen (see “Access the Modem Configuration Interface” on 

page 28), click Advanced in the menu bar on the left side of the screen to expand 
the Advanced menu. 

2. Click Port Forwarding or Trigger Port to display the corresponding menu.
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Port Forwarding
The Port Forwarding menu lets you forward outside ports to inside devices so that 
users from the Internet can use shared resources such as Web servers, remote 
workstations, gaming platforms, etc. 

Note Port forwarding does NOT apply to normal browsing or downloading by users behind the 
modem, and no additional settings are needed for those functions on this menu.
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There are 11 configurable rules and one “Default Rule.” When the modem receives an 
unsolicited packet from the Internet, it will first look at rules 1-11 to see if the traffic’s 
port matches a rule. If not, the modem will see if a Default Server is present, and if so, 
pass the packet to the Default Server. If no Default Server exists, the traffic is dropped.

The modem can use one port or a port range for forwarding traffic, depending on 
which port(s) the application being forwarded uses. If only one port is needed, the Start 
and End ports should be set to the same value.

Port forwarding entries can be edited by clicking on the Edit ( ) icon in the Action 
column. You can also use the Delete ( ) icon to remove a port forwarding rule.

In the screenshot below, a user has Windows Remote Desktop set up on his computer, 
which is assigned IP address 192.168.100.33. Rule 1 is Edited (opening the Edit menu 
for the rule) and set to Active. A Service Name is given to it for reference. The Start 
and End Ports specified at port 3389, the default communication port for Remote 
Desktop. Finally, the Server IP Address of the computer is specified. Now, the user can 
access their Remote Desktop from the Internet, so long as they know the WAN 
(public) IP or DNS address that the modem is using. 
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Trigger Port
The Trigger Port allows you to configure up to 12 “trigger” ports that can open and close 
as necessary, instead of being always open. 
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Section 2C

Tools Menu

This section reviews all the settings options available through the menu bar’s Tools 
menu, including password setup, remote access, and software update.

Display the Tools Menu
1. From the Home screen (see “Access the Modem Configuration Interface” on 

page 28), click Tools in the menu bar on the left side of the screen to expand the 
Tools menu. 

2. Select Password Setup or Software Update to display the corresponding menu.
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Password Setup
The Password Setup screen lets you reset your XOHM Modem password. 

Enter your old password, and then enter and reenter the new password. Click Apply to 
save the new password.
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Software Update
The Software Update tool lets you update your XOHM Modem software.

1. When instructed to do so, download a software update from the XOHM website.  
(If the file is compressed [zipped], you will need to extract it.)

2. From the Software Update screen, click Browse, select the update binary (.BIN) file, 
and click Upload to update your software. Some updates may require you to 
reconfigure your modem.  

Important Only upload software updates provided by XOHM Care, and only after instructed to 

do so by XOHM Care. Uploading unapproved software may damage your modem.
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Section 3A

Troubleshooting

This section addresses common problems and solutions for use with your  
XOHM Modem. For more information, visit www.xohm.com.

Frequently Asked Questions

System

What are the minimum system requirements to be able to run the XOHM Modem,  
MAX-206M2 by ZyXEL?

The minimum system requirements are:

� 32MB RAM (64MB recommended)

� 20MB available hard disk space

� Available 10/100Mbps Ethernet port

� Web browser: XOHM Internet service has been tested with Internet Explorer 6 and 7, 
Firefox 1.5 and 2.0, and Safari 2.0. Other browsers may also be compatible.

What operating systems are supported?

The XOHM Modem is designed to support any current operating system.

Can I use the XOHM Modem with my Wi-Fi router?

Yes. Most commercially available Wi-Fi routers can be connected to the XOHM 
Modem. For information about connecting a router, see “Set Up a Router (optional)” 
on page 14 for XOHM Modem Setup Assistant setup or “Connect a Router 
(optional)” on page 24 for setup without the XOHM Modem Setup Assistant.
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Issues

My XOHM Modem is not working (lights are not coming on). What do I do?

� Make sure the modem’s power adapter is plugged into an active power outlet.

� If you are using a power strip or surge protector, make sure its switch is in the “ON” 
position.

� Make sure the round end of the power adapter is firmly connected to the modem’s 
power jack.

� Make sure you are using the power adapter that came with your modem. The correct 
adapter for the MAX-206M2 provides output power of 12V AC at 1 Amp.

� If you still see no lights, call XOHM Care at 877-333-XOHM (9646).

Signal Strength
Indicator

WiMAX
Signal

Phone 1 & 2
[future service]

LAN 1 & 2 Power

Download from Www.Somanuals.com. All Manuals Search And Download.



42 Troubleshooting

My XOHM Modem is not working properly (lights are coming on but I cannot connect).  
What do I do?

� Your modem may not be receiving the proper voltage. Make sure you are using  
the power adapter that came with your modem. The correct adapter for the  
MAX-206M2 provides output power of 12V AC at 1 Amp.

� The WiMAX Signal LED should be illuminated if the modem is using default settings. 
If it is not illuminated, make sure the Power LED is green. If the Power LED is red, call 
XOHM Care at 877-333-XOHM (9646).

� If neither of the LAN LEDs is illuminated:

� Make sure that your computer or router has the Ethernet cable connected to the 
Ethernet port and that the cable is properly seated. (The cable should “click” 
when it is connected.)

� Make sure the other end of the Ethernet cable is properly connected to the  
LAN 1 or LAN 2 port on the back of the XOHM Modem.

� Ethernet cables usually have clips that help secure them to Ethernet ports. If 
these clips are damaged or broken, the cable could slip out. If your Ethernet 
cables or clips are damaged or broken, replace with a new cable.

� If the cable is securely connected at both ends, but the corresponding LAN 1 or 
LAN 2 LED is still not illuminated, try using the other LAN port on the XOHM 
Modem.

� The computer may have a faulty Ethernet adapter. 

The lights on my XOHM Modem are on, but they are all red. What do I do?

� The LED indicators on the XOHM Modem should not be red if the modem is 
functioning properly. 

� Red LEDs may indicate faulty configuration. Press and hold the red Reset Button on 
the back of the device for 10–15 seconds and then release the button to restore the 
factory default settings. The modem will power cycle (turn off and on) during the 
reset process.

� If the lights remain red after reset, call XOHM Care at 877-333-XOHM (9646).
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The lights on my XOHM Modem are on, but they are blinking. What do I do?

Blinking lights indicate that the modem is in a process. It may be powering up, 
searching for a WiMAX connection, or connecting to an attached computer. For an 
overview of the modem’s LEDs, see “Modem LED Display (front panel)” on page 5.

If blinking persists and you are not able to connect with your XOHM Modem, call 
XOHM Care at 877-333-XOHM (9646).

What do I do if my browser is not working properly?

The Web interface for the XOHM Modem (http://192.168.100.1) should be accessible 
to any computer connected to the modem. If you cannot display this page, you will 
not be able to reach any network device or the internet.

� First, check the LEDs on the modem and make sure the problem is not a basic or 
wired problem. (See earlier FAQs.)

� If you have other wired or wireless adapters (802.11a/b/g/n, Ethernet, cellular [3G 
laptop adapters]) connected to other networks at the same time, your computer 
may not be sending traffic to the XOHM Modem. If your computer has multiple 
network adapters, try disabling or removing all except the XOHM Modem 
connection.

� Make sure that the computer is set to obtain an IP address automatically using 
DHCP (Dynamic Host Control Protocol). These settings may vary by operating 
system. By default, you should obtain an IP address from the XOHM Modem 
starting at 192.168.100.33.

� If your computer cannot obtain an IP address from the XOHM Modem, you may 
try to set a static IP address on the computer to see if you can access the 
modem. If the modem is using default LAN settings, the IP address on the client 
computer will need to be 192.168.100.2–254, with a subnet mask of 
255.255.255.0, and a gateway address of 192.168.100.1.

� If all else fails, reset the modem to factory defaults by pressing and holding the 
red Reset Button on the back of the device for 10 seconds.
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� If the Reset option does not work, your XOHM Modem could have corrupted 
firmware. You may need to replace the modem. Call XOHM Care at 877-333-XOHM 
(9646)

My XOHM Modem is broken. How do I replace it?

� First, try the Reset Button. Press and hold the red Reset Button on the back of the 
device for 10 seconds and then release the button to restore the factory default 
settings. The modem will power cycle (turn off and on) during the reset process. 

� If the Reset option does not work, please call XOHM Care at 877-333-XOHM (9646).

How do I reset my XOHM Modem?

Press and hold the red Reset Button on the back of the device for 10–15 seconds and 
then release the button to restore the factory default settings. The modem will power 
cycle (turn off and on) during the reset process.

Router

I am having trouble getting my router to work with my XOHM Modem. What do I do?

If the XOHM Modem’s lights are correct and you had successfully connected to  
the XOHM WiMAX network before attaching your modem, the problem is likely 
related to:

� How the router is attached to the XOHM Modem, or

� How your computer is communicating with your router.

To make sure your router is attached correctly to your XOHM Modem:

1. Check to make sure your router is plugged in and powered on.

2. Ensure the Ethernet cord connecting the router to the modem is securely 
attached.

3. Check to make sure the XOHM Modem’s LAN light is illuminated green. See 
“Modem LED Display (front panel)” on page 5.
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To make sure your computer is communicating with your router:

1. If your computer is connected via an Ethernet cord, ensure the cord is securely 
attached both to the router and your computer.

2. If your computer is connecting via Wi-Fi, ensure you have the correct Wi-Fi 
settings entered. You may want to try to connect your computer to the router 
using an Ethernet cord first.

3. If you need assistance with the above, please consult your wireless router’s 
instructions, since routers vary by manufacturer and model.

If you are still having trouble connecting, you can try to connect to the XOHM 
network again without your router by connecting your computer directly to your 
XOHM Modem. If this is successful, please consult your wireless router’s support 
options.
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General

Can I use my XOHM Modem with more than one computer? Will that impact the quality of 
the service I am receiving?

With XOHM, you can connect to the Internet in more than one location, and extend 
your service to multiple users throughout your location. You can connect up to two 
computers directly to the two Ethernet ports of the XOHM Modem, or you can attach 
a standard Wi-Fi router to one of the Ethernet ports to create a wireless local area 
network. Wi-Fi-enabled computers can connect to the modem over the Wi-Fi 
connection. The use of more than one computer will not impact the speed of your 
connection. Each user will be able to connect at the same speed.

Why does my XOHM WiMAX signal vary?

Interference due to materials between the cell tower and the modem, including 
buildings and trees, could cause the signal to be weak in specific areas, even within 
the coverage area.

How do I receive the strongest signal possible?

Use the signal strength LEDs on the modem to find the room or location with the 
strongest signal. For more information about finding a location for your XOHM 
Modem, see “Positioning Your Modem” on page 6.
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Section 4A

Important User Information

Regulatory Notices
The design of the ZyXEL MAX-206M2 Modem complies with U.S. Federal 
Communications Commission (FCC) guidelines respecting safety levels of radio 
frequency (RF) exposure for portable devices, which in turn are consistent with the 
following safety standards previously set by U.S. and international standards bodies:

� ANSI / IEEE C95.1-1999, IEEE Standard for Safety Levels with Respect to Human 
Exposure to Radio Frequency Electromagnetic Fields, 3kHZ to 300 GHz

� National Council on Radiation Protection and Measurements (NCRP) Report 86, 1986, 
Biological Effects and Exposure Criteria for Radio Frequency Electromagnetic Fields

� International Commission on Non-Ionising Radiation Protection (ICNIRP) 1998, Guidelines for 
limiting exposure to time-varying electric, magnetic, and electromagnetic fields (up 
to 300 GHz)

FCC ID: I88MAX206M2

Caution: The ZyXEL MAX-206M2 Modem has been tested for compliance with FCC 
RF exposure limits. The ZyXEL MAX-206M2 Modem should not be used with external 
antennas that are not approved for use with this device. Use of this device in any other 
configuration may exceed the FCC RF exposure compliance limits. 

This device has been tested and found to comply with the FCC limits for a Class B 
computing device peripheral, in accordance with the FCC’s Rules. These limits are 
designed to provide reasonable protection against harmful interference in a residential 
installation.
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The antennas must be installed to provide a separation distance of at least 20cm from all persons to 
satisfy FCC RF exposure compliance.  

This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference 
to radio communication. There is no guarantee that interference will not occur in a 
particular installation.

If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following measures:

� Reorient or relocate the receiving antenna

� Increase the separation between the equipment and receiver

� Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected

� Consult the dealer or an experienced radio or television technician for help

This device complies with Part 15 of the FCC’s Rules. Operation is subject to the 
following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may 
cause undesirable operation.

Caution: Any changes or modifications not expressly approved by XOHM could void the 
user’s authority to use the equipment.

If you have purchased this product under a United States Government contract, it shall 
be subject to restrictions as set forth in subparagraph (c)(1)(ii) of Defense Federal 
Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of Defense 
contracts, and as set forth in Federal Acquisitions Regulations (FARs) Section 52.227-
19 for civilian agency contracts or any successor regulations. If further government 
regulations apply, it is your responsibility to ensure compliance with such regulations.
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Important Notice
Because of the nature of wireless communications, transmission and reception of data 
can never be guaranteed. Data may be delayed, corrupted (i.e., have errors) or be 
totally lost. Although significant delays or losses of data are rare when wireless devices 
such as the ZyXEL MAX-206M2 Modems are used in a normal manner, they should 
not be used in situations where failure to transmit or receive data could result in 
damage of any kind to the user or any other party, including but not limited to  
personal injury, death, or loss of property. User accepts responsibility for damages  
of any kind resulting from delays or errors in data transmitted or received using the 
ZyXEL MAX-206M2 Modem, or for failure of the ZyXEL MAX-206M2 Modem to 
transmit or receive such data.

General Precautions
� Do not operate the ZyXEL MAX-206M2 Modem in areas where blasting is in 

progress, where explosive atmospheres may be present, near medical equipment, 
life support equipment, or any equipment which may be susceptible to any form of 
radio interference. In such areas, the ZyXEL MAX-206M2 Modem MUST BE 
POWERED OFF. It can transmit signals that could interfere with this equipment.

� Do not operate the ZyXEL MAX-206M2 Modem in any aircraft, whether the aircraft 
is on the ground or in flight. In aircraft, the ZyXEL MAX-206M2 Modem MUST BE 
POWERED OFF. When operating, it can transmit signals that could interfere with 
various onboard systems.

� The driver or operator of any vehicle should not operate the ZyXEL MAX-206M2 
Modem while in control of a vehicle. Doing so will detract from the driver or 
operator’s control and operation of that vehicle. In some jurisdictions, operating such 
communications devices while in control of a vehicle is an offense.
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Technical Specifications

Environmental Specifications

Mechanical Specifications

LED table

Operating Temperature 0°C – 55°C 

Storage Temperature -30°C – 85°C

Humidity 5% to 90% (non-condensing)

Drop 75cm drop, no damage – fully operational

Dimensions (W x D x H) 160mm x 118mm x 167mm

Weight 480g

Battery Pack n/a

LED Yes (see table below)

Antenna Internal 5dBi omnidirectional (MIMO)

Interface Status LED Color

Power ON Solid Green

Power input low (Battery) Yellow

Modem Error Red

OFF OFF (no light)

Download from Www.Somanuals.com. All Manuals Search And Download.



52 Important User Information

LAN Not Connected OFF (no light)

10 or 100Mbps (Ethernet) Solid Green

Activity Stay Solid Green

VoIP 1 & VoIP 2 When the phone port’s defined SIP account 
for outgoing calls is registered

Solid Green

When the voice port is off-hook Flashing Green (slow)

When the phone port’s defined SIP account 
for outgoing calls is registered and there is a 
voice message in the SIP account

Solid Yellow

When the voice port is off-hook and there is a 
voice message in the SIP account

Flashing Yellow

No registered SIP accounts or device power 
OFF

OFF (no light)

WAN Signal Strength: RSSI (Power level reception) 
0 LED: > 90dBm  
1 LED: </= -90dBm - > 80dBm 
2LED: </= -80dBm - > 70dBm 
3LED: </= -70dBm

Green LED ON 
indicates signal 
strength level

LINK: WiMAX connection current 
Searching for a channel  
WiMAX network entry in progress (data being 
transferred)

Solid Green 
Flashing Green (slow) 
Flashing Green (fast)

Interface Status LED Color
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Software Specifications

Transmitter Specifications

Receiver Specifications

WiMAX Standard IEEE 802.16e-2005

PRL (preferred roaming list) support

Authentication EAP-TLS, EAP-TTLS

Mobile IP support

Normal Output Power 33dBm

TX Max Power 33dBm

Frequency Range 2.5GHZ – 2.7GHz

Bandwidth 5M, 10M

Modulation Method QPSK, 16QAM, 64QAM

Frequency Range 2.5GHZ – 2.7GHz

Bandwidth 5M, 10M

Modulation Method QPSK, 16QAM, 64QAM

Receiver Sensitivity -99dBm at QPSK
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Hardware Specifications

Interface Type Ethernet and VoIP

Common Air Interface WiMAX

Channel Spacing 250 KHz

Supply Voltage 12 V DC

Communication Ports 2 Ethernet

Voice Capability 2 VoIP
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Section 4B

Manufacturer’s Warranty

ZyXEL warranty
With the following warranty, ZyXEL guarantees that this product will be free from any 
defects due to inferior materials or workmanship, for a period of up to one (1) year 
from the date of purchase. During the warranty period, should the product prove 
defective in workmanship and/or materials, ZyXEL will repair the product and/or 
replace the defective components or the defective product without charge on 
following terms:

Terms
1. This warranty is valid upon shipment of product as recorded by serial number out 

of ZyXEL’s warehouse. 

2. This warranty does not award any right to compensation or cover of losses inflicted 
due to any alteration of the product for the purpose of matching it with national or 
local standards and safety regulations enforced in any country other than the 
country where the product was first purchased, without ZyXEL’s prior written 
permission. 

3. This warranty will not apply if the product model or serial number has been 
defaced, modified, removed or is illegible. 
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4. This warranty does not cover:

4.1 Any adaptation and/or modification for the purpose of improvement and 
enhancement of the product’s usual range of application as described in the 
user guide without ZyXEL prior written permission.

4.2 Damages due to:

a) Misuse, including but not limited to: (1) use of the product for the purpose    
other that that it is deigned for, or failure to follow ZyXEL user guide, and (2)     
product installation or operation in conditions other than specified by the     
standards and safety regulations enforced in the country of operation;

b) Repair by anyone except for ZyXEL RMA center or dealers;

c) Accident, lightning, water, fire, improper ventilation and other causes that 
does not come under ZyXEL control;

d) Shipment except for those cases when its carried out by ZyXEL’s RMA 
center;

e) Defects of the system in which the product was operated. 

5. This warranty does not infringe upon customer’s legal rights given to him by the 
laws currently enforced in his country as well as consumer’s rights toward the 
dealer arising from the sale contract. 
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Index

A
accessories 7
advanced menu 32–35
advanced settings menu

options 31
antenna connectors 4

C
configuration interface

access 28
home screen 30
password 29
URL 28
user name 29

connection details 17
connectors (illus.) 4
current status 15

E
Ethernet ports 4

F
front panel display (illus.) 5

I
install modem (with setup assistant) 

10
install modem (without setup 

assistant) 21–24

L
LED display (illus.) 5

M
modem

connectors 4
LED display 5
overview 2–7
positioning 6

modem setup (with setup assistant) 
10

modem setup (without setup 
assistant) 21

modem setup assistant - see 
XOHM Modem Setup Assistant

P
password 29

change 29
password setup 37
phone ports 4
port configuration 33
port forwarding 33
positioning your modem 6
power jack 4

R
regulatory notices 48
reset button 4
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router setup (with setup assistant) 
14

router setup (without setup 
assistant) 24

S
setup assistant - see XOHM Modem 

Setup Assistant
signal strength 20
software update 38

T
telephone (VoIP) settings 25
tools menu 36–38
trigger port 35
troubleshooting 40–46
trusted CAs 37

U
user name 29

V
VoIP 25

W
Welcome i

X
XOHM Modem Setup Assistant  

8–20
connection details 17
current status 15
install modem 10
installation 8
router setup 14

Z
ZyXEL warranty 55
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